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Digital City Marketing is an NYC printing 
company that offers premium quality 
services on offset, digital, large format and 
specialty printing. When it comes to printing 
in New York City, we know that businesses 
and individuals alike need a printer they can 
rely on. Simply providing exceptional quality 
isn’t always enough. We know you need 
quick turnaround times, reliability, flexibility, 
convenience and competitive pricing. That’s 
why since 2008, people throughout the City 
have been turning to Digital City Marketing 
for their personal and business needs 
including same-day and rush printing on our 
digital presses and printers. 

Everything we do is defined by our commitment to quality and the 
attention to detail that your marketing products deserve.  No matter what you 
need printed, how quickly you need it completed or the size of your printing job, 
you can rest assured that you are receiving the best printing services in NYC, 
along with the highest level of customer service. Choose Digital City Marketing 
as your printer every time and watch your printing make an impact.

About
Us

PRINT ON AN HP INDIGO WITH LIQUID INK 
TECHNOLOGY, NOT WITH TONER
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Bleed: a term that refers to printing that extends beyond the trim edge of your document. 
The bleed gives the printer a small amount of wiggle room to accommodate paper and 
design inconsistencies.

Trim: the final size of a product after its unnecessary parts have been cut off or removed.

Live Area: is the area where your art and type should be safely tucked into so they are 
not trimmed or cut-off.

PDF: (Portable Document Format) is a file format created by Adobe Systems in 1993 
for document exchange. PDF is used for representing two-dimensional documents in 
a manner independent of the application software, hardware, and operating system.

TIFF: (Tagged Image File Format) is a high-resolution loss-less file format that is ideal for 
saving images for print.

DPI: Dots per inch (DPI) is a measure of spatial printing or video dot density, in particular 
the number of individual dots that can be placed within the span of one linear inch (2.54 
cm). The DPI value tends to correlate with image resolution, but is related only indirectly.

PPI: Pixels per inch or pixel density is a measurement of the resolution of devices in 
various contexts; typically computer displays, image scanners or digital camera image 
sensors.

Image Resolution: describes the detail an image holds. The term applies equally to digital 
images, film images, and other types of images. Higher resolution means more image 
detail.

EPS: Encapsulated PostScript is a DSC-conforming PostScript document with additional 
restrictions intended to make EPS files usable as a graphics file format. In other words, 
EPS files are more-or-less self-contained, reasonably predictable PostScript documents 
that describe an image or drawing, that can be placed within another PostScript 
document.

Color Separations: The process of separating full-color photographic transparencies or 
prints into the four process ink colors: cyan, magenta, yellow, and black (CMYK). Most 
color separations are now done by computerized scanning of the original image.

Process Color: referred to as process color or four color, is a subtractive color model, 
used in color printing, also used to describe the printing process itself. CMYK refers to the 
four inks used in most color printing: cyan, magenta, yellow, and key black.

PANTONE Color: The PANTONE MATCHING SYSTEM is the definitive international 
reference for selecting, specifying, matching and controlling ink colors.

JPEG (Joint Photographic Experts Group): might be the most common file type you run 
across on the web, and more than likely the kind of image that is in your company’s MS 
Word version of its letterhead. JPEGs are known for their “lossy” compression, meaning 
that the quality of the image decreases as the file size decreases. You can use JPEGs for 
projects on the web, in Microsoft Office documents, or for projects that require printing 
at a high resolution. Paying attention to the resolution and file size of JPEGs is essential 
in order to produce a nice-looking project.

GRAPHICS & PRINT PRODUCTION  TERMINOLOGY
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PNG (Portable Network Graphics): are amazing for interactive documents such as web 
pages, but are not suitable for print. While PNGs are “lossless,” meaning you can edit 
them and not lose quality, they are still low resolution. The reason PNGs are used in 
most web projects is that you can save your image with more colors on a transparent 
background. This makes for a much sharper, web-quality image.

GIF (Graphics Interchange Format): are most common in their animated form, which 
are all the rage on Tumblr pages and in banner ads. It seems like every other day we 
have a new Grumpy Cat or Honey Boo Boo animated GIF. In their more basic form, GIFs 
are formed from up to 256 colors in the RGB colorspace. Due to the limited number 
of colors, the file size is drastically reduced. This is a common file type for web projects 
where an image needs to load very quickly, as opposed to one that needs to retain a 
higher level of quality.

PSD (Photoshop Document): are files that are created and saved in Adobe Photoshop, 
the most popular image editing software ever! This file format contains “layers” that 
make modifying the image much easier to handle....This is also the program that 
generates the raster file types mentioned above. The largest disadvantage to PSDs is 
that Photoshop works with raster images as opposed to vector images.

AI (Adobe Illustrator Document): is, by far, the image format most preferred by 
designers and the most reliable type of file format for using images in all types of 
projects from web to print, etc. Adobe Illustrator is the industry standard for creating 
artwork from scratch and therefore more than likely the program in which your logo 
was originally rendered. Illustrator produces vector artwork, the easiest type of file to 
manipulate. It can also create all of the aforementioned file types. Pretty cool stuff! It is 
by far the best tool in any designer’s arsenal.

INDD:  (InDesign Document) are files that are created and saved in Adobe InDesign. 
InDesign is commonly used to create larger publications, such as newspapers, 
magazines and eBooks. Files from both Adobe Photoshop and Illustrator can be 
combined in InDesign to produce content-rich designs that feature advanced 
typography, embedded graphics, page content, formatting information and other 
sophisticated layout-related options.

Raster: images are constructed by a series of pixels, or individual blocks, to form an 
image. JPEGs, GIFs, TIFFs and PNGs are all raster images. Every photo you find online 
or in print is a raster image. Pixels have a defined proportion based on their resolution 
(high or low), and when the pixels are stretched to fill space they were not originally 
intended to fit, they distort resulting in blurry or unclear images. In order to retain pixel 
quality, you cannot resize raster images without compromising their resolution. As a 
result, it is important to remember to save raster files at the exact dimensions needed 
for the application.

Vector: images are far more flexible. They are constructed using proportional formulas 
rather than pixels. EPS, AI and PDF are perfect for creating graphics that require 
frequent resizing. Your logo and brand graphics should have been created as a vector, 
and you should always have a master file on hand. The real beauty of vectors lies in 
their ability to be sized as small as a postage stamp, or large enough to fit a football 
field.

Working with images is a lot more complicated than at first glance. Hopefully this guide has provided a better understanding 
of the standard file types and which are most appropriate for your project.
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These are all great programs that 
have different purposes. Knowing when to 
use them can save you - and us - a lot of 
time and effort. In general, InDesign is a 
great program to use for anything that has 
multiple pages. This can mean newsletters 
or booklets, but it is also great for things 
like business cards and brochures. Master 
pages allow you to quickly apply changes to 
every page in the document without having 
to individually edit each page. Illustrator, 
in addition to creating logos and vector 
drawings, can also be used for layouts. If 
you are designing anything that has only 
one page or is only one-sided, Illustrator 
can be a good option. Photoshop is best 
used for photos and photo editing. You 
may use it as layout software if that is all 
you have available, but it is not as flexible 
as other programs and files will not be as 
easy to edit later on.

Adobe Photoshop
•	 For photographs and rasterized images only.
•	 Text is best left to other applications like Illustrator or InDesign.
•	 When using Photoshop, it is NOT recommended to enlarge images 

because this will result in pixelated images and poor print quality.

Adobe Illustrator
•	 Illustrator works with vector images, which are based on mathematical 

formulas. This means images created in Illustrator can be scaled up or 
down without loss of quality, as can happen with rasterized images in 
Photoshop.

•	 Illustrator is great for text that will be used as a design element, or logos.

Adobe InDesign
•	 This is a layout program that is used to combine text and graphics.
•	 It is best to compose large areas of text in InDesign rather than Illustrator 

or Photoshop.
•	 Place images designed in Photoshop or Illustrator into your InDesign 

layout to bring everything together and get it ready for print production.    

Which
program 
should I 
use?
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Before creating a PDF from InDesign, 
please keep in mind:

•	 Fonts: Ensure that all fonts are loaded 
and active prior to creating your PDF.

•	 Image Resolution: As a rule, all Photo-
shop images should have a resolution 
of 300 dpi. Any bitmap should be at 
600 dpi.

•	 Color Separations: Run off laser sep-
arations to be certain your document 
will separate correctly.

•	 Color Space: ALL RGB images should 
be converted to CMYK.

•	 Spot Colors: If you’ve used Pantone 
spot colors in your design but do not 
require them to be printed as spot 
colors, convert Spot Colors to Process 
by clicking the Ink Manager button in 
the Output Menu and checking the “All 
Spots to Process” checkbox.

•	 Color Separations: Run off laser sep-
arations to be certain your document 
will separate correctly.

•	 Bleeds: Extend all elements that run 
off the edge of the page an additional 
1/8” beyond the final trim size.

•	 Document Size:...Create your docu-
ment at the final size you would like it 
produced. Avoid building on an over-
sized layout (for example, don’t build a 
3.5”x2” rectangle on an 8.5”x11” page 
if you want a business card). Pay par-
ticular attention to panel sizes where 
one panel may need to be narrower 
to accommodate a fold (for instance, 
a tri-fold brochure).

•	 Transparency & Drop Shadows: Set 
the Transparency Flattener to High 
Resolution.

Creating a PDF from Adobe InDesign Under the File menu, choose Export, 
name your PDF file, and choose “Adobe PDF”

How to
convert a 
PDF from 
InDesign?
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One crucial step when setting up 
your print documents is to remember 
to accommodate for bleed. Again, the 
exact amount may vary from company 
to company and product to product, but 
3mm or 0.25” is a common figure. Bleed 
is the area around your final document 
dimensions where your design is extended. 
This allows for slight inaccuracies when the 
printed sheets are being trimmed down to 
size. If the sheet is misaligned slightly, the 
bleed will avoid leaving a thin white strip of 
plain white paper down the edge of your 
design.

Only elements that touch an edge of your design need to extend into the 
bleed area. Background photos or images should be large enough to fill the 
entire bleed size (remember bleed area is trimmed off). Make sure your logo 
and any text elements are placed well away from the edges of the document 
so they don’t get accidentally cropped or look like they’re about to fall off the 
edge. It’s often useful to designate a “safe margin” between 5-10mm from 
the edges using guides. Place all your design elements within this safe zone to 
nicely balance your artwork on the page.

InDesign: File>Document Setup>Set Bleed To .125” to all sides
Illustrator: Document Setup>Set Bleed To .125” to all sides
Photoshop: Image>Canvas Size>Add .25” to both height and width

What is
bleed?

NO
BLEEDBLEED

* THE BORDER IN THIS COLOR REPRESENTS THE TRIM LINE
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The standard image resolution 
for printing is 300 dpi or higher. Files 
that are lower in resolution have a 
tendency to not be as clear or sharp. 
It’s important to begin with a high-
quality image, which means the highest 
resolution and image dimensions you 
can get. When it comes to source 
images, bigger is better, because you 
can go down in size, but not up, without 
losing quality.

DPI stands for “dots per inch” and PPI 
translates to “pixels per inch.” These 
units of measure are essential for 
determining if the density of pixels 
in an image is appropriate for the 
application you are using.

The biggest thing to note when 
determining what DPI or PPI you require 
is if you are using an image for print or 
web. Websites display images at 72 
dpi, which is low resolution; however 
images at this resolution look really 
crisp on the web. This is not the case 
for print. Best practices for printing an 
image will require it to be no less than 
300 dpi. The more dots, the higher the 
quality of the print (more sharpness 
and detail).

Don’t try to trick the system. A lot of 
magic can happen in Photoshop, but 
creating pixels out of thin air isn’t one 
of them. Pulling an image off of the web 
and trying to get it to fit the dimensions 
of your print project just won’t work. 
You will end up with a pixelated image 
that appears stretched and distorted.

What image 
resolution
should I
use?

600x900
900x1500
1200x1800
1500x2100
1800x2400
2100x2700
2400x3000
3300x5100
3600x5400
7200x10800
10800x14400
14400x21600

2x3
3x5
4x6
5x7
6x8
7x9
8x10
11x17
12x18
24x36
36x48
48x72

WEB
72 DPI

(SCREEN RES)

PRINT
300 DPI

(HIGH RES)

72-300 DPI
Conversion Chart

Low resolution image at 72 dpi, which will look crisp on your monitor, but looks pixelated when printed.

72 DPI300 DPI
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When a user generates graphics on 
a computer for printing, or wishes to print 
images from a digital camera, it is a common 
mistake to assume that the colors seen on 
the screen will look the same in print. As a 
result of this mistake, files for printing are 
often erroneously sent in the Red-Green-
Blue (RGB) format. The issue lies in the 
fact that the computer screen and many 
photo editing programs show colors in RGB 
mode, while images are printed on paper in 
Cyan-Magenta-Yellow-Black (CMYK) format. 
Sometimes the conversion from RGB to 
CMYK works without any problems arising, 
and a printout will look identical to what 
shows up on the computer. In other cases, 
there will be noticeable differences between 
the shades of color. The key to avoiding this 
potential problem is to convert all graphics 
to CMYK format during the layout and 
design phase.

RGB is the color scheme that is associated with electronic 
displays, such as CRT, LCD monitors, digital cameras and scanners. It 
is an additive type of color mode, that combines the primary colors, 
red, green and blue, in various degrees to create a variety of different 
colors. When all three of the colors are combined and displayed to 
their full extent, the result is a pure white. When all three colors are 
combined to the lowest degree, or value, the result is black. Software 
such as photo editing programs use the RGB color mode because it 
offers the widest range of colors.

Printers print color onto paper using the CMYK color mode 
only. This is a four color mode that utilizes the colors cyan, magenta, 
yellow and black in various amounts to create all of the necessary 
colors when printing images. It is a subtractive process, which means 
that each additional unique color means more light is removed, or 
absorbed, to create colors. When the first three colors are added 
together, the result is not pure black, but rather a very dark brown. 
The K color, or black, is used to completely remove light from the 
printed picture, which is why the eye perceives the color as black.

The RGB scheme has a greater range of colors than CMYK and can produce colors 
that are more vivid and vibrant. These colors are beyond the range of CMYK to reproduce 
and will come out darker and more dull in print than what is seen on the monitor or display. 
Because the RGB color mode has the full range of colors, documents shown in CMYK 
mode will always show up precisely on-screen. RGB colors, however, will not necessarily 
appear in print as they do on-screen. To accurately print the document or image, it must be 
converted from its original RGB format to CMYK. It is possible to do this by using software 
such as Adobe Photoshop or Adobe Illustrator.

What color
mode
should my
files be for
print?

RGB COLOR MODE

CMYK COLOR MODE

WHY RGB COLORS NEED TO BE CONVERTED?

RGB

CMYK
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WARNING: GRAYSCALE IMAGES CONVERTED INTO CMYK 
MODE MAY EXPERIENCE A COLOR SHIFT IN THE FINAL PRINTED 
PIECE.

Double check the CMYK values of your 
grayscale. There is a possibility that the 
color will vary if the file contains values 
other than K.

To remove all values other than K, go to 
your Channel Mixer in Photoshop. This 
is under the Adjustment Layer option. 
Then select “Monochrome” to make the 
necessary changes.

Overprint is a process to intentionally 
overlap inks for a variety of reasons. 
However, it can create unexpected or 
undesirable results. Please make sure that 
this “Overprint” option is turned off before 
sending your files.

What
happens if
I convert a
grayscale
image into
CMYK?

What is an
overprint
and how 
can it affect
my file?

CMYK Grayscale
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Trapping is a prepress procedure 
that introduces areas of color into color 
separations. When printed, these areas 
obscure potential register errors.

These errors are usually caused by the 
paper shifting or changing shape while it 
is printed, or by presses or plates that are 
out of register. As a result, the colors print 
incorrectly.

Excessive register error is evident when 
the colors in an image appear blurry, but 
typical register error is much more subtle. 
When colors go out of register, the edges 
of touching colors either overlap, creating 
an unattractive color intersection, or they 
spread apart, creating a partial outline 
of white paper showing through (See the 
illustration on the left).

Compensating for register error involves 
corrective trapping elements which can be 
surprisingly complex, for artwork can have 
many different colors and types of color 
intersections.

The methods for creating corrective 
trapping elements must be extra-
ordinarily sophisticated—they must resolve 
every possible press register error for 
any combination of colors and printing 
elements.

When using blue in your design, 
always make sure to leave at least a 30% 
difference in your Cyan and Magenta 
values. Blue is very close to purple in the 
CMYK print spectrum. Use as little amounts 
of magenta as possible.

•	 For best results, trapping should be applied by the printer and not in the   
application. Trapping settings made in the application are not included in 
the PostScript when printing with the Composite mode.

•	 Avoid instances where trapping to gradients or images is required 
        (the change in color may not reproduce well).

What is 
trapping?

How can I 
avoid my 
blues
coming out 
as purple?

WITH TRAP

WITHOUT TRAP

Same color
after printing.On Screen
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Rich black contains a mixture of 100% 
K along with additional CMY values. This will 
enable you to achieve a darker tone than 
just black ink alone. We recommend that you 
use the following values:  
C=60  M=40  Y=0  K=100.

There are three different ways Pantone 
colors can affect the way your job prints.

The first is by object effects, such as 
shadows or glows, on top of your Pantone 
colors. To avoid this, convert all your Pantone 
colors into CMYK before submitting your 
order.

The second way Pantone colors can affect 
your file is when you use transparent images.

The last way Pantone colors can affect 
your order is the color conversion between 
a Pantone color and CMYK. If you use 
Pantone colors in a job that will print CMYK, 
your job might print with undesirable colors.

How do I
define a 
rich black?

How can
Pantone 
colors
affect the 
way my
job prints?

RICH BLACK100% BLACK

Here is what the effects will look like on screen:
(1)

(2) (3)

Here is what a transparent 
image looks like on screen:

You can see the image is no longer transparent on top of the Pantone 
color. These white areas will show up during printing. To fix this issue, 
convert all your Pantone colors into CMYK. If you need to have a Pan-
tone color in your art, for example when doing a silver 877c job, you 
must create a clipping mask around the image so the white area will 
not show up. This must be done before submitting the order.

Here is what a transparent 
image looks like after printing:

Here are some 
examples 
of what the 
Pantone color 
looks like in the 
Pantone color 
book and what 
the CMYK print 
will look like:

Here is what the effect looks like after printing:
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Here are some general rules of thumb when you create a 
multi-page booklet:

•	 The page count starts with the cover as Page 1. The inside front cover will 
be page 2 and each consecutive page follows with 3, 4, 5...

•	 The file must be in single pages. We will not accept readers or printers 
spreads.

•	 Multi-page PDFs are preferred but single-page PDFs are also accepted.
•	 Allow .25” for the total bleed outside the trim and a .5” for the total safety 

inside the trim.

For example, a 5.5 x 8.5 booklet with bleed should be 5.75 x 8.75 and an 8.5 x 
11 booklet should be 8.75 x 11.25.

Crossovers are any images, graphics or text that extend from one page to 
another. They require special attention in order to be printed properly.

Crossovers work best when used with large images and artwork. Try to avoid 
faces in the fold area. Allow for text to have a larger safety area and avoid 
having text in the fold area.

Any artwork created in InDesign or other layout software as facing pages or 
spreads should be saved as a single-page PDF.

See the instructions on the top right about how to set up your document in Adobe InDesign.

How do I 
set up a 
booklet 
that has 
multiple 
pages?
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When ordering Spot UV business cards, 
a Spot UV mask for the business card is re-
quired. In this short tutorial, we will show you 
how to properly set up a Spot UV mask. 
Please note that the Spot UV masks CAN-
NOT contain any gradients, drop shadows, 
or low resolution graphics. All mask files must 
be a separate file from your main print files.

How to set
up a Spot 
UV mask
file?
Quick Tip – This tutorial also applies to Spot UV/AQ, Embossing, Debossing, Foiling and other Spot UV 
masks as the mask prepping is the same.

Step One: Getting You Started
First, you’ll have to determine whether or not you will need Spot UV for one side of the business 
card or both sides. If your business card will only have Spot UV on one side, you should have a 
total of three files (front print, back print, front Spot UV mask). Having Spot UV on both sides of 
the business card should have a total of four files (front print, back print, front Spot UV mask, 
back Spot UV mask). These Spot UV masks must be on a WHITE background and the Spot UV 
selection must be filled with 100% K (black).

Step Two: Establishing Your Mask
We will be adding Spot UV on both front and back of the business card. The Spot UV look that 
this business card will achieve is the ‘black-on-black’ look that’s very popular with Spot UV. 
Proper file naming conventions are very important to ensure that the Spot UV lines up prop-
erly. For example if submitting Jpeg files you would name them:  1. Front.jpg    2. Front_Spot.
jpg   3. Back.jpg   4. Back_Spot.jpg

Step Three: Confirm Your Mask Placement
Please keep in mind that during production Spot UV can shift up to 1/16”. We advise that you 
DO NOT use Spot UV for small, thin text because of a possible shift. Spot UV is a transparent 
UV Coating that is applied to the top layer of the business card. Spot UV can also make cer-
tain colors more vibrant due to its high gloss coating. Below is an example of where the Spot 
UV masks will be placed. The Spot UV masks are highlighted in a magenta color to show the 
placement of your mask.

This is the front print file (should not contain any 
Spot UV masks or markings). This file is strictly 
for print and has nothing to do with the Spot UV 
mask.

This is the back print file (should not contain any 
Spot UV masks or markings). This file is also strict-
ly for print and has nothing to do with the Spot 
UV mask.

This is the front Spot UV mask file. This file MUST 
be separate from your front print file. The mask 
file needs to be on a white background and your 
Spot UV selection must be filled with 100% K 
(black). Anything filled with 100% K, will be in Spot 
UV. The white area will be matte.

This is the back Spot UV mask file. This file MUST 
be separate from your back print file. The mask 
file needs to be on a white background and your 
Spot UV selection must be filled with 100% K 
(black). Anything filled with 100% K, will be in Spot 
UV. The white area will be matte.

FRONT

FRONT_SPOT

BACK

BACK_SPOT



When using InDesign, a great way to make sure your printer will receive ev-
erything they need to correctly print your document is to create a “Package” 
containing all of the necessary files. Fonts, images and other necessary items 
are put in one folder that you can easily send to your printer.

InDesign does this automatically with its “Package” function. To package your 
InDesign file:
1. Open your file in InDesign.
2. Click File > Package...
3. Go through the menu options on the left and check:
a. Fonts: All the fonts you want to use are in the list and the status for each 
one is OK. Click “Find Font...” if anything is missing.
b. Links & Images: Make sure each image type says “CMYK” and not RGB and 
that the status of each image is “Linked.” We prefer linked, rather than em-
bedded images because it saves disk space. If any of the images are missing, 
click on them in the list and then click “Relink.”
4. Click the “Package...” button.
5. Choose a descriptive name for the text file that will be included with the 
package. This file will contain instructions for the Prepress team. It is also help-
ful if you fill out the other requested information (Contact, Company, Address, 
Phone, Fax, Email). Click “Continue.”
6. Select a destination for the packaged folder (preferably the same folder 
your original InDesign file is located in) and give it a descriptive name. Click 
“Save.”
7. The packaged folder will be created in the location you specified. Make sure 
it contains:
a. A .txt file
b. An InDesign file
c. A Fonts folder containing all the fonts you used (there may be “extra” fonts 
in this folder 
d. A Links folder containing all the images you used
8. Compress or “zip” this folder and send it to your Print Provider.

More about the Package function
The Package dialogue box has several menu options that will help you ensure all fonts and images are 
linked or embedded, and that the colors are correct. These options can help you locate issues in your 
InDesign document you may not have been aware of.

Summary
Information about the document is displayed here, including any errors that are found (such as
images that are not in CMYK, missing fonts and images).

Fonts
This lists all the fonts that are used in the document. It tells you the name of the font, what type it is
(PostScript, TrueType, etc), and if it is present or missing. If there are errors, select the specific font
and then click “Find Font...” to see available options. You can change the font in the “Find Font”
window, if you wish. Each instance of the original font will be changed to the new font you specify
in the “Replace With” section of the “Find Font” dialogue box.

How do you package your 
InDesign files for print?
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Digital Prepress… the most complicated part of printing for both printers and 
designers alike. Common Problems: no bleed, missing fonts, low resolution 
photos, full color black text, files saved and packaged incorrectly. 
The next time you design a project and submit it to us for printing, take a peek at this list and your life 
and our job should be much easier!

When creating documents to send for digital output, please ensure that:
      The document dimensions are correct and at the right size for output.
      All images are correctly positioned and linked.
      Logos or graphics created in programs like Illustrator, have all type
      converted to paths or outlines.
      In your page layout program, the status of all imported pictures or links
      should be “ok.”
      You have only used fonts that you intended to use for output.
      All unused colors have been deleted.
      Check that spot colors are converted to CMYK.
.........All document bleeds have been extended at least 3mm beyond the
      desired finished size of your project.
      All documents have been proofread and double-checked before
      submission. Have a friend proofread it!

Design & Prepress Checklist:
      Do not use Publisher or Freehand. Stick to Adobe Products for ease of 
.........use.
      Try not to use Microsoft Office programs like Word or Excel. If you
.........have no alternative, generate a PDF of your final file.
      Remember, Photoshop is for photos. Illustrator is for illustrations. InDesign  
.........is for Page Layout.
      Do not use RGB images whenever possible. Convert them to CMYK.

Before submitting files, please make sure that you have included:
      All fonts required to process and print the document.
      All attached EPS and/or TIFF/JPG files.
      Final laser prints of all document pages.

If all else fails, submit a PDF with appropriate bleeds and crop marks. 

Acceptable formats are PDF, JPG and TIFF. Files created from Microsoft 
PowerPoint, Word, Excel or other programs must be given to us already 
imaged in a high-resolution PDF file (at least 300dpi resolution).

Supported Applications
• InDesign • Illustrator • Photoshop • Acrobat

Prepress Checklist

What types of file formats 
are acceptable?
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WIRE BINDING
Wire binding is a popular commercial book binding method, and is known by a number of 
different names including twin loop wire, wire-o, double loop wire, double-o, ring wire and 
wirebind. With this binding method, users insert their punched pages onto a “C” shaped 
spine and then use a wire closer to squeeze the spine until it is round. Documents that 
are bound with wire binding will open completely flat on a desk and allow for 360 degree 
rotation of bound pages.

SADDLE STITCHING
A saddle stitch is appropriate for small booklets and, in general, for volumes with only 
a few pages. Most magazines that are not glued are saddle stitched: that is, they are 
held together by staples that run through the gutter. Once the pages are aligned and 
in the right order, this type of binding is quite straightforward. Staplers with extremely 
long jaws, designed specifically for saddle stitching. Saddle stitching can also be done to 
the individual codex, using a needle and thread, as part of the process of binding them 
together into a larger book.

PERFECT BINDING
Perfect bound books add a certain style and sophistication to the look and feel of your 
books, which just can’t be matched by spiral and comb binding. Perfect binding gives you 
a professional quality soft cover style book and is the only binding option that allows you 
to print on the spine. We print your cover on a cardstock sheet that wraps around the 
interior pages of the book creating the front cover, spine, and back cover. The interior 
pages are then glued into the spine of the book.

CASE BINDING
Case binding is the process for making hardcover books, such as reference books, 
yearbooks, children’s books, novels, vanity books, coffee table books, art books, law books, 
medical books and most custom books. The advantages of case binding a book are the 
strength and durability you get from the various case binding techniques. The look of 
the hardcover book is also superior with the availability of leather, papers and multiple 
fabrics that can be used to encase the book. These materials coupled with the variety 
of specialty finishing techniques, such as embossing or foil stamping, give the casebound 
book a professional, classy, or artistic look. A printed dust jacket can also be applied to 
finish off your book.

DIE CUTTING
Create shapes and contours giving your printed piece a dynamic edge. This process utilizes 
sharp steel rules to define shapes. It can be performed on either a flatbed or rotary 
press. Decorative elements or patterns can be punched out and eventually incorporated 
into a larger piece. Create interesting folds, flaps or even holes if necessary for hanging. 
Commonly used for envelopes, cards, stickers, labels, business cards, magnets, door-
hangers, boxes ... 

29



ENGRAVING
Engraving, in a printing context, is a method of creating raised areas of print or images on 
paper, such as a business card or letterhead. An impression is created on a metal plate, 
which is then filled with opaque ink. When paper is pressed into the plate, it creates raised 
and colored areas. A similar effect can be created by thermographic printing . Engraving 
and gravure are the two most common forms of intaglio printing

Using engraving, an artist can make either highly detailed images or images with a sketchy 
quality, depending on the number and thickness of the engraving lines.

EMBOSSING AND DEBOSSING
Makes peaks or valleys on your printed piece. Embossing is a technique where a design 
is impressed onto a particular stock. The design is “raised” when graphics or type is 
pressed into the paper from underneath. This requires a male/female die combination. 
The raised area can have a surface where ink has been applied. It can even have foil or be 
intentionally left blank (un-primed) known as a blind emboss. Debossing is the opposite 
process where the imprint causes a “depression” on the paper or stock.

FOIL STAMPING
Foil stamping is a special kind of printing procedure where heat, pressure, and a metallic 
paper (foil) is used to create different shiny designs and graphics on various materials. 
Foil stamping gives the stamped design a shiny and incredible look and is increasingly 
becoming the preferred method of printing in many an industry.

Foil stamping is also referred to as hot stamping (because of the use of heat), foil printing, 
dry stamping, and leaf stamping. There are various types of foil stamping that can be 
used depending on your design needs.

Foil mask files are set up just like our Spot UV mask files. The file can only be black and 
white. All black areas should be 100k or only 100% black with no other colors added. Black 
in the areas you want the foil and white in the areas you do not want the foil. If you order 
a Foil job with Spot UV, you must provide separate mask files for the Foil (foil mask) and 
UV (spot uv mask). In that case, up to 6 files will need to be provided.

MOUNTED CARDS
These cards make a bold and lasting impression and feel different from run-of-the-
mill cards. The added thickness also adds strength and resilience. When we say added 
thickness, we mean 2x, some even 3x thicker than standard. Make a strong first impression 
and stand out from the crowd with a mounted card.

LABELS & STICKERS
Businesses rely on quality label and sticker printing for a wide variety of uses, from brand 
promotion to selling and shipping products, offering crisp, eye-catching labels and stickers 
in a convenient and cost-effective manner.

We digitally print labels on a vast array of paper stock and substrates. This affords you 
incredible flexibility to test out various designs on different mediums, change images and 
text, and engage in just about any type of personalization or customization you desire. 
Since digital label printing does away with pricey set-up costs, such as film and plate 
charges, you can also take advantage of short-run label and sticker printing, allowing you 
to order only as many as you need.
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HP INDIGO
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Let’s Face The Difference!

Liquid INK or TONER
Let’s Face The Difference!

Liquid INK or TONER
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COMMERCIAL REGULAR
5 —

61 / 4 —

61 / 2 —

65/ 8 —

7 —

73/ 4 —

8 (Monarch) —

85/ 8 —

9 —

10 —

10 1 / 2 —

11 —

12 —

13 —

14 —

31 / 1 6 x 5 1 / 4

31 / 2 x 6

31 / 2 x 6 1 / 4

35/ 8 x 6 1 / 2

33/ 4 x 6 3/ 4

37/ 8 x 7 1 / 2

37/ 8 x 7 1 / 2

35/ 8 x 8 5/ 8

37/ 8 x 8 7/ 8

41 / 8 x 9 1 / 2

41 / 2 x 9 1 / 2

41 / 2 x 10 3/ 8

43/ 4 x 11

45/ 8 x 11 1 / 4

5 x 11 1 / 2

COMMERCIAL WINDOWS
61 / 4 —

63/ 4 —

7 —

73/ 4 —

8 (Monarch) —

85/ 8 —

9 —

10 —

10 1 / 2 —

11 —

12 —

13 —

14 —

35/ 8 x 6

35/ 8 x 6 1 / 2

33/ 4 x 6 3/ 4

37/ 8 x 7 1 / 2

37/ 8 x 7 1 / 2

A & B Window

37/ 8 x 8 7/ 8

41 / 8 x 9 1 / 2

41 / 2 x 9 1 / 2

41 / 2 x 10 3/ 8

43/ 4 x 11

45/ 8 x 11 1 / 4

5 x 11 1 / 2

BOOKLET
21 / 2 —

3 —

41 / 2 —

5 —

6 —

61 / 2 —

65/ 8 —

63/ 4 —

71 / 4 —

71 / 2 —

9 —

91 / 2 —

10 —

13 —

41 / 2 x 57/ 8

43/ 4 x 6 1 / 2

51 / 2 x 7 1 / 2

51 / 2 x 8 1 / 8

53/ 4 x 87/ 8

6 x 9

6 x 91 / 2

61 / 2 x 9 1 / 2

7 x 10

71 / 2 x 10 1 / 2

83/ 4 x 11 1 / 2

9 x 12

91 / 2 x 12 5/ 8

10 x 13

CLASP

10 —

15 —

25 —

35 —

40 —

50 —

55 —

63 —

68 —

75 —

81 —

83 —

87 —

90 —

93 —

94 —

95 —

97 —

98 —

105 —

110 —

33/ 8 x 6

4 x 63/ 8

45/ 8 x 6 3/ 4

5 x 7 1 / 2

51 / 2 x 71 / 2

51 / 2 x 8 1 / 4

6 x 9

61 / 2 x 9 1 / 2

7 x 10

71 / 2 x 10 1 / 2

81 / 4 x 11 1 / 4

81 / 2 x 11 1 / 2

83/ 4 x 11 1 / 4

9 x 12

91 / 2 x 12 1 / 2

91 / 4 x 14 1 / 8

10 x 12

10 x 13

10 x15

11 1 / 2 x 14 1 / 2

12 x 15 1 / 2

OPEN-END CATALOG

8 Glove —

7 Glove —

1 Scarf —

3 Scarf —

41 / 2 Scarf —

6 Scarf —

1 Catalog —

1 3/ 4 Catalog —

3 Catalog —

6 Catalog —

8 Catalog —

81 / 2 Catalog —

93/ 4 Catalog —

10 1 / 2 Catalog —

12 1 / 2 Catalog —

12 Catalog —

13 1 / 2 Catalog —

15 Catalog —

14 1 / 2 Catalog —

15 1 / 2 Catalog —

37/ 8 x 7 1 / 2

4 x 63/ 4

45/ 8 x 63/ 4

5 x 7 1 / 2

51 / 2 x 71 / 2

51 / 2 x 8 1 / 4

6 x 9

61 / 2 x 9 1 / 2

7 x 10

71 / 2 x 10 1 / 2

81 / 4 x 11 1 / 4

81 / 2 x 10 1 / 2

83/ 4 x 11 1 / 4

9 x 12

91 / 2 x 12 1 / 2

10 x 12

10 x 13

10 x15

11 1 / 2 x 14 1 / 2

12 x 15 1 / 2

A-LINE
ANNOUNCEMENT STYLE

A-2 —

A-6 —

A-7 —

A-8 —

A-9 —

A-10 —

A-Long —

43/ 8 x 63/ 4

43/ 4 x 6 1 / 2

51 / 4 x 71 / 4

51 / 2 x 8 1 / 8

53/ 4 x 8 3/ 4

6 x 91 / 2

67/ 8 x 87/ 8

BARONIAL

3 —

4 —

Gladstone —

5 —

51 / 2 —

6 —

31 / 4 x 41 / 4

35/ 8 x 51 / 8

35/ 8 x 75/ 8

41 / 8 x 55/ 8

43/ 8 x 53/ 4

43/ 4 x 61 / 2

REMITTANCES

61 / 4 —

61 / 2 —

63/ 4 —

9 —

10 —

31 / 2 x 6

31 / 2 x 6 1 / 4

35/ 8 x 6 1 / 2

37/ 8 x 87/ 8

41 / 8 x 9 1 / 2

SQUARE BOOKLET
From 41 / 2 to 91 / 2

in 1 / 2 inch increments

Other popular envelopes are:  First-Class Mailer, Strip and Grip, String and Button, Latex Seal, Open Policy, Coins and Wallet Flap.

ENVELOPE
SIZE CHART
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Bond 
Ledger

Text
Book

Cover 
Cardstock

Index
--

Pt
--

16 40 22 33 3.2 
18 45 24 37 3.6 
20 50 28 42 3.8 
24 60 33 50 4.8 
28 70 39 58 5.8 
29 73 40 60 6
31 81 45 66 6.1 
35 90 48 74 6.2 
36 90 50 75 6.8 
39 100 54 81 7.2 
40 100 56 83 7.3 
43 110 60 90 7.4 
44 110 61 92 7.6 
47 120 65 97 8
53 135 74 110 9
54 137 75 113 9
58 146 80 120 9.5 
65 165 90 135 10 
67 170 93 140 10.5 
72 183 100 150 11 
76 192 105 158 13 
82 208 114 170 14 
87 220 120 180 15 

105 267 146 220 18 

HOW TO USE THE CHART 
When selecting a paper stock, keep in mind the
equivalents to each paper choice available.
This will be able to tell you how thick the paper will
be and assist you in making the right selection. 
Note that Bond, Text, and Cover are usually in LB. If for example the paper
stock is a 14 pt. cover, then it used points (pt) and not pounds (lbs).   

PAPER WEIGHTS 

Bond Paper
A light-weight stock, also known as Ledger or Writing.
It is commonly as 24 LB or 28 LB Bond Weight.   

Text Paper
Also known as Offset, Text Paper is thicker than
Ledger Paper, but not as thick as a Cover Paper.
Stationery usually has a 70 LB or 80 LB Text Weight.   

Cover Paper
A Card Stock or Pasteboard paper. Known commonly
to be used for business cards and greeting cards,
but can also be applied to brochures and flyers.
It is commonly used as 80 LB Cover Weight, although
some brands of paper offer cover weight paper
that is 100 LB or heavier.  

PAPER TYPES 

Coated
Stock that has a surface sealant and relates to
sheen: gloss, matte, dull and satin finishes.
Works well particularly with photos.

Gloss
Stock that has a high sheen; most magazines
use gloss paper. 

Dull and Satin
Stock that has a smooth surface paper that is low
in gloss. Dull and Satin coated paper falls between
matte and glossy paper. 

Matte
A non-glossy, flat looking paper stock. 

Uncoated
Stock that has not been coated with clay or other
surface sealants. Cannot be combined with UV
or Aqueous coating.  

COATING TERMS 

C1S

Coated one side. 
C2S
Coated both sides. 

Paper Weight Comparison Chart Table of Paper Sizes From A0 to A10

Format

A0
A0+
A1
A1+
A2
A3  
A3+  
A4  
A5  
A6  
A7  
A8  
A9  
A10  

 mm

841mm × 1189mm
914mm × 1292mm
594mm × 841mm
609mm × 914mm
420mm × 594mm
297mm × 420mm 
329mm × 483mm 
210mm × 297mm 
148mm × 210mm 
105mm × 148mm 
74mm × 105mm 
52mm × 74mm 
37mm × 52mm 
26mm × 37mm 

Inches

33.1” × 46.8”
35.9” × 50.8”
23.4” × 33.1”
24” × 36”
16.5” × 23.4”
11.7” × 16.5”
12.9” × 19.0”
8.3” × 11.7”
5.8” × 8.3”
4.1” × 5.8”
2.9” × 4.1”
2.0” × 2.9”
1.5” × 2.0”
1.0” × 1.5”

US Paper Sizes

Format mm Inches

Letter 216mm × 279mm 8.5” × 11”
Legal 216mm × 356mm 8.5” × 14”
Junior Legal 203mm × 127mm 8” × 5”
Ledger 432mm × 279mm 17” × 11”
Tabloid 279mm × 432mm 11” × 17”

COMMERCIAL REGULAR
5 —

61 / 4 —

61 / 2 —

65/ 8 —

7 —

73/ 4 —

8 (Monarch) —

85/ 8 —

9 —

10 —

10 1 / 2 —

11 —

12 —

13 —

14 —

31 / 1 6 x 5 1 / 4

31 / 2 x 6

31 / 2 x 6 1 / 4

35/ 8 x 6 1 / 2

33/ 4 x 6 3/ 4

37/ 8 x 7 1 / 2

37/ 8 x 7 1 / 2

35/ 8 x 8 5/ 8

37/ 8 x 8 7/ 8

41 / 8 x 9 1 / 2

41 / 2 x 9 1 / 2

41 / 2 x 10 3/ 8

43/ 4 x 11

45/ 8 x 11 1 / 4

5 x 11 1 / 2

COMMERCIAL WINDOWS
61 / 4 —

63/ 4 —

7 —

73/ 4 —

8 (Monarch) —

85/ 8 —

9 —

10 —

10 1 / 2 —

11 —

12 —

13 —

14 —

35/ 8 x 6

35/ 8 x 6 1 / 2

33/ 4 x 6 3/ 4

37/ 8 x 7 1 / 2

37/ 8 x 7 1 / 2

A & B Window

37/ 8 x 8 7/ 8

41 / 8 x 9 1 / 2

41 / 2 x 9 1 / 2

41 / 2 x 10 3/ 8

43/ 4 x 11

45/ 8 x 11 1 / 4

5 x 11 1 / 2

BOOKLET
21 / 2 —

3 —

41 / 2 —

5 —

6 —

61 / 2 —

65/ 8 —

63/ 4 —

71 / 4 —

71 / 2 —

9 —

91 / 2 —

10 —

13 —

41 / 2 x 57/ 8

43/ 4 x 6 1 / 2

51 / 2 x 7 1 / 2

51 / 2 x 8 1 / 8

53/ 4 x 87/ 8

6 x 9

6 x 91 / 2

61 / 2 x 9 1 / 2

7 x 10

71 / 2 x 10 1 / 2

83/ 4 x 11 1 / 2

9 x 12

91 / 2 x 12 5/ 8

10 x 13

CLASP

10 —

15 —

25 —

35 —

40 —

50 —

55 —

63 —

68 —

75 —

81 —

83 —

87 —

90 —

93 —

94 —

95 —

97 —

98 —

105 —

110 —

33/ 8 x 6

4 x 63/ 8

45/ 8 x 6 3/ 4

5 x 7 1 / 2

51 / 2 x 71 / 2

51 / 2 x 8 1 / 4

6 x 9

61 / 2 x 9 1 / 2

7 x 10

71 / 2 x 10 1 / 2

81 / 4 x 11 1 / 4

81 / 2 x 11 1 / 2

83/ 4 x 11 1 / 4

9 x 12

91 / 2 x 12 1 / 2

91 / 4 x 14 1 / 8

10 x 12

10 x 13

10 x15

11 1 / 2 x 14 1 / 2

12 x 15 1 / 2

OPEN-END CATALOG

8 Glove —

7 Glove —

1 Scarf —

3 Scarf —

41 / 2 Scarf —

6 Scarf —

1 Catalog —

1 3/ 4 Catalog —

3 Catalog —

6 Catalog —

8 Catalog —

81 / 2 Catalog —

93/ 4 Catalog —

10 1 / 2 Catalog —

12 1 / 2 Catalog —

12 Catalog —

13 1 / 2 Catalog —

15 Catalog —

14 1 / 2 Catalog —

15 1 / 2 Catalog —

37/ 8 x 7 1 / 2

4 x 63/ 4

45/ 8 x 63/ 4

5 x 7 1 / 2

51 / 2 x 71 / 2

51 / 2 x 8 1 / 4

6 x 9

61 / 2 x 9 1 / 2

7 x 10

71 / 2 x 10 1 / 2

81 / 4 x 11 1 / 4

81 / 2 x 10 1 / 2

83/ 4 x 11 1 / 4

9 x 12

91 / 2 x 12 1 / 2

10 x 12

10 x 13

10 x15

11 1 / 2 x 14 1 / 2

12 x 15 1 / 2

A-LINE
ANNOUNCEMENT STYLE

A-2 —

A-6 —

A-7 —

A-8 —

A-9 —

A-10 —

A-Long —

43/ 8 x 63/ 4

43/ 4 x 6 1 / 2

51 / 4 x 71 / 4

51 / 2 x 8 1 / 8

53/ 4 x 8 3/ 4

6 x 91 / 2

67/ 8 x 87/ 8

BARONIAL

3 —

4 —

Gladstone —

5 —

51 / 2 —

6 —

31 / 4 x 41 / 4

35/ 8 x 51 / 8

35/ 8 x 75/ 8

41 / 8 x 55/ 8

43/ 8 x 53/ 4

43/ 4 x 61 / 2

REMITTANCES

61 / 4 —

61 / 2 —

63/ 4 —

9 —

10 —

31 / 2 x 6

31 / 2 x 6 1 / 4

35/ 8 x 6 1 / 2

37/ 8 x 87/ 8

41 / 8 x 9 1 / 2

SQUARE BOOKLET
From 41 / 2 to 91 / 2

in 1 / 2 inch increments

Other popular envelopes are:  First-Class Mailer, Strip and Grip, String and Button, Latex Seal, Open Policy, Coins and Wallet Flap.

ENVELOPE
SIZE CHART

Bond 
Ledger

Text
Book

Cover 
Cardstock

Index
--

Pt
--

16 40 22 33 3.2 
18 45 24 37 3.6 
20 50 28 42 3.8 
24 60 33 50 4.8 
28 70 39 58 5.8 
29 73 40 60 6
31 81 45 66 6.1 
35 90 48 74 6.2 
36 90 50 75 6.8 
39 100 54 81 7.2 
40 100 56 83 7.3 
43 110 60 90 7.4 
44 110 61 92 7.6 
47 120 65 97 8
53 135 74 110 9
54 137 75 113 9
58 146 80 120 9.5 
65 165 90 135 10 
67 170 93 140 10.5 
72 183 100 150 11 
76 192 105 158 13 
82 208 114 170 14 
87 220 120 180 15 

105 267 146 220 18 

HOW TO USE THE CHART 
When selecting a paper stock, keep in mind the
equivalents to each paper choice available.
This will be able to tell you how thick the paper will
be and assist you in making the right selection. 
Note that Bond, Text, and Cover are usually in LB. If for example the paper
stock is a 14 pt. cover, then it used points (pt) and not pounds (lbs).   

PAPER WEIGHTS 

Bond Paper
A light-weight stock, also known as Ledger or Writing.
It is commonly as 24 LB or 28 LB Bond Weight.   

Text Paper
Also known as Offset, Text Paper is thicker than
Ledger Paper, but not as thick as a Cover Paper.
Stationery usually has a 70 LB or 80 LB Text Weight.   

Cover Paper
A Card Stock or Pasteboard paper. Known commonly
to be used for business cards and greeting cards,
but can also be applied to brochures and flyers.
It is commonly used as 80 LB Cover Weight, although
some brands of paper offer cover weight paper
that is 100 LB or heavier.  

PAPER TYPES 

Coated
Stock that has a surface sealant and relates to
sheen: gloss, matte, dull and satin finishes.
Works well particularly with photos.

Gloss
Stock that has a high sheen; most magazines
use gloss paper. 

Dull and Satin
Stock that has a smooth surface paper that is low
in gloss. Dull and Satin coated paper falls between
matte and glossy paper. 

Matte
A non-glossy, flat looking paper stock. 

Uncoated
Stock that has not been coated with clay or other
surface sealants. Cannot be combined with UV
or Aqueous coating.  

COATING TERMS 

C1S

Coated one side. 
C2S
Coated both sides. 

Paper Weight Comparison Chart Table of Paper Sizes From A0 to A10

Format

A0
A0+
A1
A1+
A2
A3  
A3+  
A4  
A5  
A6  
A7  
A8  
A9  
A10  

 mm

841mm × 1189mm
914mm × 1292mm
594mm × 841mm
609mm × 914mm
420mm × 594mm
297mm × 420mm 
329mm × 483mm 
210mm × 297mm 
148mm × 210mm 
105mm × 148mm 
74mm × 105mm 
52mm × 74mm 
37mm × 52mm 
26mm × 37mm 

Inches

33.1” × 46.8”
35.9” × 50.8”
23.4” × 33.1”
24” × 36”
16.5” × 23.4”
11.7” × 16.5”
12.9” × 19.0”
8.3” × 11.7”
5.8” × 8.3”
4.1” × 5.8”
2.9” × 4.1”
2.0” × 2.9”
1.5” × 2.0”
1.0” × 1.5”

US Paper Sizes

Format mm Inches

Letter 216mm × 279mm 8.5” × 11”
Legal 216mm × 356mm 8.5” × 14”
Junior Legal 203mm × 127mm 8” × 5”
Ledger 432mm × 279mm 17” × 11”
Tabloid 279mm × 432mm 11” × 17”
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